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١ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

  ب"* ا3 ا��#
- ا��#	*

  �م�ـــم4


�%%*  ا�%%%� ه%%%
 -:ا(آ%%%�' ��&%%�$# � و$���+%%*  ا&%%�1ء  ا�/�&%%�$#  و.��%%*  ا(و	%%,  �%%�ا$#  $+
 ����%%* وآ�%%�ءة �%%���* ا���9%%�ة وا(�%%���8* ا�7%%����* ا��� �%%�ت واج%%�اء ا(��34و&�%%* ا�+%%�اول

  -:$�ی A/3& B ا�/�&�$# �1@�' و�/�ء ا�/��&�* وا��س
م ا��<==�ت ا>�	* آ;ا�:

Start → All Programs → Microsoft Office → Microsoft Excel 
2003 

  ش�ح ن�'9ة ا�آ"7

3
اه%%� ا�
ی�%%�وز &
ا	%%; $%%� ا���ی%%� �%%1/� ا(آ%%�' &�	%%;ة�) E%% � Fا8� ش%%�ی
%%� Fادوات وش%%�ی 
Fان وش�ی
�  -:ا�B��3 ا� '41	B آ�� ا���	;ة �

  

  

  

�I ی��L3 س
ف ا���9سB ا(دوات ش�یF $�      ج�ی� ای9
&* � F@J& E ج�ی� $ I و�< �� Book1 ج�ی� $
 $� ی43
ن ج�وال �� �/�رة ا�
ا��ة ا���' وور�*  Work Sheet أوراق ��' OPث $� �����دة ی43
ن وا�;ي

د 256 هB ا(���ة ��د ��A-IV U ا(&+ �Tی* ا(�+�ی* فا(�� هB ا(���ة ���وی� وص�
ف ا���ة� ا$� �


ف��
د �A��9 &�3+* هB خ �* وآ' 65536 ا�� �$1  ����3 �' $���� 	BV ا�� اس� خ �* و�4' ا��A$ I ا��

د و A1 U�� A اس��V ا(و�E ا�< �* ( ً $U اخ�ى خ �* $A (ی�43ر� و���$� ه	 ر�� ا��� 1 ه
 ر$T ا��
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٢ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

F@J& E � ]ن خ �* اي	ف ا�< �* اس� 
 Name Box ا�< �* اس� ص��وق ی��E خ�ص ص��وق 	B ی\�V س
   .Active Cell) (ا��1=* ا�< �* هB ا�< �* ه;^ و�4
ن

  ا�< �* 	B ا��a ادخ�ل

�%%� خ �%%* اي 	%%B ا���34%%* ارد&%%� اذا	 �%%��%%�وس � �F@J%%��� �%%V وذ�%%: ا�< �%%* ��F�1%% س%%
ى � ���� 

�* ��ی� �� ا�< �* �Eا $/�ش�ة ا�P *��34� ا(ی���  L�����  ا�

  ا�<Oی� $� &=�ق 	B ا�/��&�ت ادخ�ل

 �%��  F@J%وا�%%�ة $%�ة  ا�  E% �  *%� >]&%�  ا�	ف 
 ��7ی%%� ��($4%�ن  و�4%�  وا�%%�ة خ �%%* ��7ی%�  ی%3�  س%%
�%%dخ �%%* $%%� اآ ,��%%� e%%�
 ���%%F@J ا(س3%%��ار P%%� ا��%%�وس ا(ی%%��  �%%Tر ���%%F@J وذ�%%: ا�


�%%* � %%E وا��7�%%� ی%%3� س%%
ف ذ�%%: ��%%� $3+%%�ورة �%%4
ن ان �%%�1ط و�4%%� ا�<Oی%%� $%%� $+
 ا(و�%%E ا�< �%%* 	%%B &34%%� ا�/��&%%�ت  وgدخ%%�لRange Of Cellsا�<Oی%%�  $%%� &=%%�ق ��7ی%%�


�%%* ا�/��&%%�ت =��%%� خ �%%* ) (Tab$�3%%�ح  &%%F@J ا����3%%* ا�< �%%* ا�%%E ا(&93%%�ل ارد&%%� واذا ا� 9��� 
�%%�) (Enter $�3%%�ح او ا���%%�� ا�%%E وا�%%�ة 9� �%%� ا�B%%3 ا��%%���* ان � �%%� 'ا(س%%� ا�%%E خ �%%* ��


ق ا�<Oی� ا�/��&�ت &�34 و&j$ �7ش�ة �/E9 س
ف ��7ی�ه�	  

  ا�?
	� م!�)��ت ت=��7

 &Edit) (B%%4� A�=3�%% ��7ی%%� ���%%* 	%%B ا�< �%%* و>%%A 	�+%%� ا�< �%%* 37$
ی%%�ت ��%%�ی' ارد&%%� اذا
 �$%% ��%%�ی' او �%%�P L�7%%� و$%%� � %%E ا�< �%%* ا��%%Tدوج ���%%F@J وذ�%%: 37$
ی��E%% � �%%V ا��3%%�ی'

 ش%%�ی F	B%% وا�%%�ة &9%%�ة ه%%Edit B)( ��7ی%%� ���%%* 	%%V �+& B%%� ا�B%%3 ا��d&�%%* ا�=�ی%%� او &�ی%%�^
*@��  . ا�

  ( Move Between Work Sheet) ا�=
7 اوراق ب	- ا���74

'%%9�  ا���%%' ور�%%* اس%%� � %%F@J%%��� E ذ�%%: ی%%3� ا(آ%%�' ��&%%�$# 	%%B ا���%%' اوراق �%%�� � 3

(Sheet1,Sheet2..) ی%%%%� �%%%%� او�� L���%%%%�$ %%%%/�4ردا�
Ctrl+Page up  او Ctrl+ 
Page Down.  

  ا�=
7 اوراق ت"
	� ا$�دة

�4���* ا��دة واخ��3ر ا���' ور�* � E ای�� $��3ح ��ی� �� وذ�: ا���' اوراق ����* ا��دة ی�� Rename 
�P م
8�* ا�E و&;ه� ا���' ور�* اس� ��7ی� ��ی� او�� ا�+�ی� ا(س� �9& *��34�� ����� Format) (واخ��3ر 

�' �*ور� Work Sheet) (ا��دة اخ��3ر ذ�: و��� *���� Rename) (س)م ��دخ�ل ا
� ا�;ى و��� ذ�: &9
  .Enter&�ی�^ P� ا�E � F@J ذر 

��� �	
  Save work Book ا�آ�� 


ج� أآ�d $� ��یI $ m�7� �9 اlآ�'�  

8�* ا�E  ا�;ه�ب- ١�� I $ File) (واخ��3ر m�� (Save).  

٢ - �$ *�
� L�����  .E � (Ctrl+S) ا�F@J ا�
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٣ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

٣ - �$ Fا(دوات ش�ی Bا���9س F@Jوا� E � *&
   ا�m�7 ای9

E��3ا� m�7ا� A��$ ��� �V\ف ی
  و	B آ' ا��7(ت س

  

  

B�' C
  .اGآ"7 ب�ن�مE' F م)ج)د م

   أی�V� �J أآ�d $� ��ی�9

١ – I $ *�8�� Eا�;ه�ب إ� File) ( L3	 E � F@Jوا�Open).(  

٢ -�$  *�
� L�����  .E � (Ctrl+O)  ا�F@J ا�

٣ -�$  Fا(دوات ش�ی Bا���9س F@Jوا� E � *&
  $   I	L3 ای9
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٤ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

  

  اGآ"7 ب�ن�مF م- وا�?�وج ا�

C اHIق

8�%%* $%%� ا$%%� �%%�ی��39 ه�%%�ك ا�� %%O%%@ � Iق�� I%% $ File) واخ�3%%�ر) �%% t Closeاو )( �%%� 
%%3
ح � �%%�تا� ج��%%A اO%%tق ارد&%%� واذا (X)  ا��O$%%* ذو اO%%tق ا�%%E%% � T ا�%%F@J ��ی%%��� ا�

8�%%* ا�%%E و&%%;ه� Shift) (ال $�3%%�ح &%%F@J وا�%%�ة $%%�ة�� I%% $ File) (واخ�3%%�ر O%%tا�4%%' ا 
(Close All) ه� ا�/�&%%%�$# $%%%� و� <%%%�وج;%%%& E%%%ا� *%%%�8�� I%%% $ (File) خ%%%�وج واخ�3%%%�ر 

)(Exit ل $%%� اوO%%خ F@J%%ا� E%% � ذو ا�/�&%%�$# $%%� ا�<%%�وج زر *%%$Oا�� (X) B%%	 E%% ا� 
  .ا���	;ة

  ماGر�L ت�"	&

%4
ن  �%%� ا(ر�%�م  ار�%�م  �%%� �/%�رة  ه%B  ا(آ%%�' ��&%�$#  	%V�$  B%%� &��3$%'  ا�B%3  ا�/��&%%�ت $�\%� � 

ی%%* &%%�� او آ%%�
ر او �%%�ریu او روا�%� v$ '�%%ا(آ  A%$ '%%$��3اع ی
 ا�/��&%%�ت ه%;̂  $%%� ��ی%�ة  ا&%%
 *%�� ا�%E  ا�%;ه�ب  P%�  ا�<Oی%�  ��7ی%%� ( ً او 	� ��%�  $7%�دة  خOی%�  	%%B ا(ر�%�م  ��%���  ارد&%�  اذا ا���

� *%%�8�   ���%%��Format) ( �%%P  ی%%�   &<3%%�رOخCells) ( ف
�%%�  ی\V%%�  س%%�  A%%��$  ار
%%�  ���%%�� 
�� ا����A ا�7
اري ا�Number) (E��3ار��م  $�� &<�3ر خOی�� �V\ی �P.  
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٥ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

  

  :آ�����E هE اGر�Lم ت�"	& م- $���ة ان)اع وه��ك

  ا���3یI  ا��)ع
General  �V\ا���� ی ������ ��ون 34$
ب ه
 آ�  
Number  V\اص' ا���� �ی
  ا���ص * ��� ا���ا�� ��د ��7ی� وی��4 ��1ی* ��

Currency  I�Jی T$ر * �  &�ی�ه� ا�B3 ا��� * ��7ی� وی��4 ا���� ج�&� ا�E ا��
Accounting  I�Jی T$ر * �  ا��$T ا�E $�7ذاة ��' $A ا��

Date  ���  ��ریu شE � '4 ا���� ی
Time  ���  و�e و��ریu شE � '4 ا���� ی

Percentage I�Jی T$ر */��
ی* ا�v�  ا���� ا�E ا�
Fraction '�+ا���� ی E � '4ر ش
  آ�

Scientific ������* ار��م �41' ا(ر��م � �  
Text �V\ا���� ی ������ ��ون 34$
ب ه
 آ�  

Special �9ت���خ�ص*  Eا(ر��م ا�  
Custom �4����� ار�� ان ی� ��t �9ت���  ا(خ�ى ا�3

N!س���ال ا��Gوا  

�%%* �%%� ا�/U%%7 ارد&%%� ذارا�� *%%���$ '%%d$ ء ار�%%�م�� ا���%%' اوراق 	%%B اخ%%� ش%%B اي او اواس%%
�%%� ا�B%%3 ا�/��%%�ت ه%%;^ اس%%3/�ال ارد&%%� اذا وآ%%;ا�:d7� �%%V� ��ی%%� �%%� ه%%;ا آ%%' اخ%%�ى �/��&%%�ت �

 A%%��$  ار
%%�  U%%7�  واس%%3/�ال (Find And Replace)  4%%�  وا�%%;ي� $%%�  ا��%%�  ا�
ص%%%
ل ی

ح اس%%3<�ام  ��ی%%%� �%%%� او) (U%%7� Find  رواخ�%%%�3 (Edit ) ��7ی%%�  ��8�%%%* خ%%Oل %%%� L���%%%�� ا�

(Ctrl + F) E��3ا� A����� ا�� �V\ف ی
  .وس
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٦ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

  

  ا�
��وط ا���"	&

�%'  ا�%E  ا���ً&%�  &37%�ج �  ���%��  E%ی%�  ا�O>ی%3�  ا&%�  اي $�%��  ش%�ط  �%��  و�4%�  ا�)  ���%� �97%�  اذا ا( ا�3
 &7%�د  ذا�%:  و���%'  جLا��%�  $%�  ا��اس%�  &��%T  ان و&�ی%�  ا�=%Oب  درج%�ت  ذا�%:  � %d$  E%�ل  ا�%�1ط 

*%%�
�8�%%* ا�%%E &%%;ه�  (Range Of Cells )�%%Pا�<Oی%%�  $+��  ���%%��Format) (واخ�3%%�ر  ���%%��
�� ا����A ا�B��3 (Conditional Formatting)$�1وط � �V\س�.  

  

  ةوا��� وص�
ف خOی� و�;ف ا>�	*


�%�  &%I�J  ان &�ی%�  ا�%;ي  &�7دا�%�I  :ص%I  �%;ف  او (>%�	* 	  I%ج�ی%�  ص  �%P  ه�;%&  E%ا�  *%� ادراج ��8
Insert) ( و&<3%�ر   I%صRow) ( �33%س   I%* ص	و�7%;ف  ج�ی%�  ا>%�  I%7%�د  ص&  I� ا�%E  &%;ه�  P%�  ا�%

*�  (Delete). �;ف واخ��3ر (Edit) ��7ی� ��8


د  �%;ف  او (>%�	* %�
د  &7%�د  :�%�
د  �/ %�  &%I�J  ان &�ی%�  ا�%;ي  ا��%� ادراج ��8�%*  ا�%E  &%;ه�  P%�  ج�ی%�  �
(Insert)  د   و&<3%�ر
%��(Column)  �%<* س%33� ا	د  
%�
د  و�7%;ف  ج�ی%�  �%�
د  &7%�د  �%� &%;ه�  P%�  ا��

Eا� *�   .�(Delete);ف   واخ��3ر(Edit)��7ی�  ��8
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٧ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

 (Cell)واخ�3%�ر خ �%�   (Insert)    ادراج ��8�%*  ا�%E  &%;ه�  خ �%�  (>%�	*  -:خ �%*  �%;ف  او (>%�	* 
�V\�%%س A%%��$ ار
   ��7ی%%�  ��8�%%* ا�%%E &%%;ه� خ �%%� ارد&%%� �%%;ف   واذا(Insert)ا(>%%�	*  �%%

(Edit) واخ��3ر �;ف(Delete) ار ا�7;ف
� A��$ �V\وس� .(Delete)  

  ا�?��H م!�)ى وم"B ون"R ن74

8�%%%* ��7ی%%%�        �� E%%%ه� إ�;%%%& �%%%P �>�%%%& اد &9 %%%� او�%%%��9%%%' و&%%%�u ا�<Oی%%%� &%%%9
م ��73ی%%%� ا�+%%%Tء ا�� )(Edit �%%%P 
)&%%%9
م ��خ�3%%%�ر ا($%%%� Copyی%%%�ت  (
%%%9
م ���%%%T��%%%� F@Jر ا(ی%%%�� 	%%%E ا��4%%%�ن ا��%%%�اد &37$ '%%%9& �%%%P  �%%%یO>ا� 

  *%%�8�� E%%ه� إ�;%%& �%%P �%%�	)      (Edit  �%%$gم ��خ�3%%�ر ا
�%%� أی%%�J إس%%�73ام ش%%�ی(Past)  F  و&%%9�4�وی
              �%%%$ L���%%%��
ج%%%� أی4
&3%%%�ن وا�%%%�^ � �%%%�u واgخ%%%�ى � %%%�� آ�%%%� ی�4%%%� إس%%%�73ام �
�%%%* ا�� U%%%�� دواتgا

��L و (Ctrl + C)خOل اlخ3��رات ا}���  � )Ctrl +V( �� � .  

  ا��T ت�"	&

�4����� &a ا�<Oی� $� خOل ش�یF اgدوات ا���9سB ی� ��
ر^�
> L	E ا�$ 
  آ�� ه

  

  

       *%%%�8�� E%%%ل ا�%%%;ه�ب إ�O%%%ا8� $%%%� خ
�%%%� إس%%%�73ام ا�%%%9�4��%%%�  P (Cells)%%%� &<3%%%�ر  (Format)آ�%%%� ی� �V\�%%%س 
 ��
اري &<�3ر $� A��$(Font).  
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٨ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

u�& ����  ا�3

         u�%%& اد�%%��%%� &%%�u ا�3�%%��� وذ�%%: $%%� خ%%Oل �\ �%%' ا ا��4��P �V9��%%%%� ا�%%E%% � F@J ای4
&%%*      ی�Format 

Painter     ا�دوات ا���������� �������� �  /.����- ذ�����+ $����*(� )&����� ا�'&�����% ا�"�����اد $�����#       ا�"	!����	د  �����
  .ا�2�345 إ���0

  ا�<Oی� ا�E ��ود ا>�	*

             �%%%V �+�إن ا�7%%%�ود ا�E%%%3 &�اه%%%� 	%%%E ��&%%%�$# اlآ%%%�' $%%%� ه%%%B إ( خ%%%�ود وه��%%%� ( �\ �%%%V	E%%% ا�=/��%%%� و�
�V�	 �473وا� �V\�B�{�� م
9&   

Format → Cells → Border 

B��3ارى ا�
�� ا����A ا�7� �V\س�  

  

  

�'�U7 اVا�  ا� ��H?ا�  


ان ا�<Oی� �3 
ی���� ����$ ���73� �V\$ ی�O>ا�B�{�� م
9&   

Format → Cells → Patterns 
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٩ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

 

  ا�<Oی� د$#


�%%%� $%%%� ا�<Oی%%%� $%%%� خ%%%Oل �\ � P �%%%V%%%� ا�%%%E%%% � F@J ای4   ��%%%� د$%%%# $+�4�
ج%%%
د^ ی�
&%%%* ا�%%%�$# ا�

 Bدوات ا���9سgا Fش�ی E	 

  ا���' ور�* ا�E و�;ی' رأس ا>�	*

   �7��
$%%%�ت �%%%�ریu أو ر�%%%� ا�%%% ��
$%%%�ت أ� %%%E أو أس%%%�' ا�%%%���7 س%%%
اء آ�&%%%e ه%%%;^ ا� �$ *	�%%%<l

 
�%%%�   View →Header And Footer أو $%%%� ش%%%��� &%%%9
م �%%%�}�B ) ص%%%
ر^ ( أو �
ج%%%� �%%%V\ی
B��3اري ا�
  ا����A ا�7

  

  

  ا���7* ه
ا$� ���@�

File → Page SetUp 

�� ا����A ا�7
ار ا�E��3 وا�;ى &<�3ر $�� ه
ا$� � �V\یMargins  
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١٠ 
    

  ا�2�	�    م��وع ت/)�� ا�
�ارس                                               #"- إب�اه	* ت)'	&                             / إ$�اد 

  


�* ا���7* ا�+�ة �@��/=�  ا�

�%�ء Pن  ا�=/%�ع  ا
%4�  *7��
دی%*  ا�%�� (Portrait) �9%*   او	ا(Landscape) :ا�/��&%%�ت آ%%;ا� 
 *%�
/=�
�%*  ا�
ر�%*  �7+%�  ج� V%�  ی�4%�  ا�/=�%��E   ا��)Scaleه%;̂  (  a8�� $%�  >%/=�V  ی�4%�  ا�<%

8�%%* خ%%Oل��  I%% $(File) 7*  ا�%%�ادات واخ�3%%�ر��
اري &%%9
م  (Page Setup)ا�%%%%� A%%��$ �%%�� �V\�%%س 
   (Page)��خ��3ر 

  

���
ف �+��  وا(���ة ا�

 	%�ن  ا�+%�وال  اس%�'  ا�%E  ا�3��ی%�  ��%�  �U%�7  آ�d%�ة  ص%�
ف  � %E  ی%37
ي  ج%�وال  �%�ی��  آ%�ن  اذا
 I�
ان ا�%%%%%�%%%9
م ���34%%%* ا�/��&%%%�ت  وا�%%%( ا�%%%;ى ی�d%%%' ا��& �%%%�Oم ��73ی%%%�  ) ;ى $%%� خ
%%%9& �%%%3�/d3� و� �9%%%�م E%%�3>ی

8�%%%* و&%%%�وز     �� E%%%ا�%%%;ه�ب إ� �%%%P ^�%%%�� و&%%%9
م ��خ�3%%%�ر  (Window)  ا�%%%�I ا�%%%;ى ��%%%� ا�%%%�I ا��%%%�اد �+
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 �%%��+�(Freeze Panes )   �%%$g4%%�ن &+%%� ا� Unfreeze Panes  و�l@%%�ء ا�3+��%%� &%%;ه� إ�%%E &�%%, ا�
 �� � F@J��� م
9�	 �$gء ا�@�l.  

'�  ا�/��&�* ا��<==�ت $A ا��

�%�  ا�/��&%�ت  �%�  وا���%*  	4%�ة  &%4
ن  ان (&A�=3�%  ا���&ً%� �  �%V3رؤی  E% �  '4%ج%�وال  ش  �%�	 
 ���
ر̂  ان آ�d%�ة  ���&%�ت  � %E  ی%37
ي  ا�+%�وال  آ%�ن  اذا ة خ%�صً  ا(ر�%�م  �A%/3  ا�%� وس%� *  ا	%J'  ا�%
 �%�/�3 �  �%�  A%ا�
�E  ص%
ر̂  ا�%E  ا�/��&%�ت  �7
ی%'  ا�%E  ا(آ%�'  ��&%�$#  ��%�  ی%��L  ا��%�  F%=>$   B&�%��

(Chart) ��  ..ا��<Tو&* ا�/��&�ت وا�A ��4, س
ف ا��<=F ه;ا رؤی* �

  

  

  

  ا�/��&�� ا��<==�ت $���# ��س3<�ام $<=F ا&�1ء

 :%���$<=%F   &<3%�ر  (Insert)ادراج  ��8�%*  $%�  ا��<==%�ت  $�%��#  �3%1@�'  ��ی9%*  $%�  اآd%�  ه

(Chart) ل $%%� اوO%%9%%� خ�   ا���9س%%B  ا(دوات ش%%�یF $%%� $�%%��# ا��<==%�ت  ای9
&%%* � %E  ا�
�%%' &�ی%%� ا�B%%3 ا�/��&%�ت  ��7ی%%� او( ی+%%� و��%4 � F%%=>$ B&�%%�� �%%V��  �%� $�%%��# �%%1@�' �%%�ء و�

  -:ا�B��3 ا� '41	B آ�� ا(و�E ا���	;ة �/�ء س
ف ا�3<=�=�ت

  

 �%�
ع  &7%�د  ه%&  F%=>�  س%
ف (Next) زر � %P  F@J%&  E%�  &�ی%�̂  ا�%;ي  ا�P  '41%%�  ا�/�%�&B  ا�
��V\ ^;	��  :ا����3* ا�
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 F@J& ار���� ا����A ا�7
اري ا���NextE��3س3� �V\�	   

  

  

 �$�%� ا�B%3  ا���%'  ور�%*  &7%�د  و$�V%�  ا(خ�%�ة  ا���	%;ة  �\V%�  س%
ف ) (NEXT ا�F@J%&  B��%3  و�
ا&V%�ء   &%P  F@J%�  �%�  خ�ص%*  ��%'  ور�%*  	%B  و>%��  و&A�=3�%  ا�/�%�&B  ا��<=%  F	�V%�  ی\V%�  ان &�ی%� 

.(Finish) 

  

  

  

  أن)اع ا�
?//�ت
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 اآd%�  او خ ���%3  37$
ی%�ت  ج�%d$  A%'  ه%B �/%�ر^ �%� ��/�%� ری�>%B      (Formula) ا��ی�>%�*  ا����د�%* 
  هB ا���$Oت ا����$Oت ا��ی�>�� وه;^ ��س3<�ام ذ�: ی3� $��ل او او>�ب

  ا�)W	�2  ا�
=�م7
  ا��ا�� اgس��  ^
� �* ا��Jب  *�  
+  A�� �* ا�+�  
� �* ا�=�ح  -�  
/   *� ����  ا��9

�%�  خ �%*  	%B  �%��=�  ری�>%�*  $��د�%*  ا&%�1ء  ارد&%�  اذا��$  �%�&�	  B%	  *%ا�/�ای  AJ%&  *%$O�  ا��%��وي (=)  B%	 
و&%%AJ ا��%%��# E5     و D5ا�< �%%� ا�E%%3 &�ی%%� إ.V%%�ر ا��%%��# 	�d$ �%%V%%�ل � %%E ذ�%%: �%%
 أرد&%%� ج�%%A ا�< �3%%�ن   

%%9
م 	�&�%%� 5 F	E%% ا�< �%%�& B��%%3���: '%%��& *%%� >ر ا� ا��%%V.ی%%� إ�& E%%3ا�   �%%V�	 #��%%�F5  *%%��34� م
%%9& �%%P  = �%%P

 E%%3�  = (F5 ی%%4
ن ش%%4' ا�%%��@� �%%�ی��E%% � F@J%%& �%%PD5 ا�< �%%� +  E%% � F@J%%&E5 �%%34& �%%P ا�< �%%� 

+ E5)        3%�ح�$ E% � F@J%%��� م
� �%*  &%��#  س%�\P Enter) ( �V%%� ��%� ذ�%: &%9�  A%� F5ا�< �%%*  	%%B ا�+
�%%%� 	%%%E �%%%�� ا�<Oی%%%� اgخ%%%�ى �3@�%%%� ا��9�%%%� 	%%%E خ �%%%* ا   �t �%%%�%%%4
ن   وآ � �%%%��%%%��# �/9%%%� � 3@��%%%�ات اgخ%%%�ى آ�

�/L ا���@* ش�ی F	B ا�< �* 37$
ی�ت� E � '4ری�>�* $��د�* ش eا���3دی* ���&�ت و���.  
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R"د�� ن�=
  ا����U	� ا�

 �$�%�%9
م  �&  *%� �
�%%* � %E  ری�>%�*  ��� ا�<Oی%%� � %%E ا��� �%*  ه%;̂  �=/�%�  وارد&%�  ا�<Oی%�  $%%� $+
9
م ��ی9* ی
ج� ا��3+�ورة& ���  Copy Formulas    ا��� �*  ه;^ و���E ا��� �* ه;^ خ��س3

  

�4�E وا��
X ا��
X دا�� اس�?�ام
  ا��

�8*  �� �%�ت  	%B  ا�%�وال  ه%;̂  $%�  &%���3د  ان ی�4%�  ا�%���8*  دوال ا(آ%�'  ��&%�$#  	%B  ی
ج%� �� و$%�  ا�%
 ا�/��&%%�ت �+�%A  ا�%%�وال ه%;̂  �%%9
م Auto Sum ا�B8�%%9 3 وا�+�%Sum  A  ا�+�%%A دا�%%* ا�%%�وال ه%;̂ 

�3+%�ورة ا�  E% �  '4%د  ش
%�� �%*  &%��#  ا>%�Vر  &�ی%�  ا�B%3  ا�< �%*  &7%�د  ا��ا�%*  ه%;̂  و(س%3<�ام  ص%I  او �� 

 A%�و��%� ذ�%: &%F@J       ا�B8�%9 3  ا�+�%A  ای9
&%*  واخ�3%�ر  ا���9س%B  ا(وات ش%�یF  ا�%E  وا�%;ه�ب  ا�+
  Enter$��3ح 

  دا�* ادراج ا($� اس3<�ام

�%9$��  ا�%�وال  ه%;̂  و�%4
ن  $�V%�  ا(س%��3دة  ی�B  �%4ا�3%  ا�%�وال  $%�  ا��%�1ات  � %E  ا(آ%�'  ��&%�$#  ی%37
ي  
 E%ة  ا��%v	  �%V� ادراج ��8�%*  ا�%E  &%;ه�  دا�%*  اي و(>%�	*  $�=�9%�  دوال او $���%�  دوال او ا�%���8*  دوال $

Insert) (�P دا�*  &<�3ر( Function) ف
�� ی\�V س� A��$ ار
� Insert Function   

  

 ا��ا�%*  ه%;̂  &7%�د  (Sum) ا��d%�ل  س%/�'  � %E  &�ی%�ه�  �B%3 ا ا��ا�%*  &<3%�ر  ا�%7
اري  ا����%A  ه%;ا  خ%Oل  $%� 
F@J&و E �  �	ا
$Ok) (ف

ار  ی\�V س� A��$    Function Arguments  
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�	� اYس�س	��Z#إس�?�ام ا��وال ا� 

 $7%�ودة  اt%�اض  ا�%E  �%�3<�م  خ�ص%�  ا�%�وال  ه%;̂  $%�  ا���ی%�  ا�%�وال  $%�  $v%�ت  ا(آ%�'  ��&%�$#  	%B  ی
ج%� 
  ا����3* ا(����8* ا��وال ا��وال ه;^ $� وش�A8 آ/�� �41' ��3<�م ا�B3 �والا� ��� ه� : و��4 جً�ا


7 ا��ا��  ا��ا��$  
Sum ��Hخ �$(
  ت"�?�م ��
X م�

Average ��Hخ �$(
  ت"�?�م '  #"�ب م�)س\ م�

Count ��H?ت"�?�م �!"�ب $�د ا�  

Min �
	L 7Lت"�?�م �!"�ب أ  
Max �
	L ت"�?�م �!"�ب أآ��  

��  وإذا    واخ�3%�ر  ا(دوات ش%�یF  ا�%E  &%;ه�  ا�%�وال  ه%;̂  $%�  دا�%*  اي ا>%�	* =@%<  E% � 
 *%&
%9
م  	�&�%�  ا(ی9&  *%� ���  A%��V%�  وا�%�ة  اي واس%3<�ام  ا(�%���8*  ا�%�وال  ج��%A  ا.V%�ر  ارد&%�  اذا ا$%�  ج$ 

��&�	 F@J& E � �Vا��.  

  ا���3 � * ا(ر��م اس3<�ام

 :%���� �%*  	%B  ���%�  ��(آ%�'  خ�ص%�*  ه�  O%$ ل  /��&%�ت ا��%d$  E% �  :%آ��3%*  ارد&%�  اذا ذ�  �V%اش  �� &A�=3�%  ا�%�
 ج��%A  �%;آ�  ا�<�ص%�*  ه%;̂  �%9
م  و�%;�:  Copy Formulas اس%3<�ام  ��ی%�  �%�  P%�  ا(ول ا��V1%  آ%��3* 
 �V%اش  �� وا�%���  	%B ا�< �%*   ا(ول ا�%���  &%I�J  ا(ر�%�م  وآ%;�:  ا�=�ی%�  �%��,  ا(س%/
ع  ای%�م  وآ%;�:  ا�%�
B&�dا� B	 *� >ورة ا��+�  Copy Formulas و&9
م  ا�< ���3 و&�7د ا�< �* ه;^ Eا� ا�

��7د ��دی* O� �3$ت �4
ی� ارد&� اذا ا$�	 *�
�8�* ا�E &;ه� P� ا(ول ا���� و&�34 $3+�ورة خOی� $+�� 

ار $��A ی\�V وس
ف Fill  �7Series وا��56ر Edit��7ی� � ��  .	B آ�� 	E ا�41' ا�B��3 آ
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  ���ا����) (IFإ����ام ا��ا�� 

%9
م  ا�B%3  ا��ا�%*  خ ���%3  ���%*  $�9ر&%*  ا�%E  &37%�ج �  ̂;%V�  *%��.
�%'  وا�IF  B%3 دا�%*  ه%B  ا���  A%$  تOخ�%� ا�
  ا����3*

  ا���ح  ا�
�خHت
Logical _ Test  ا��1ط B9=��  $� اص@� او $� اآ/� ی4
ن آ]ن ا�< ��3 �� &�9رن ا�;ي ا�

Value _ If_ True  *+�3�  �1طا� ��97 اذا ا��ا�* ��ج��V ا�B3 ا�
Value _ If_ False  *+�3�  ا��1ط ��97 �� اذا ا��ا�* ��ج��V ا�B3 ا�


   E6ا�< �%%*  $%%D6  A ا�< �%%* $�9ر&%%* ارد&%%� �%%
 ا��ا�%%* ه%%;^ � %% E�B%%9�/= آ�d%�ل % 	  e%&ا�< �3%�ن  آ� 
�%AJ  $3%��وی�3ن  �4
&%�  �%�  اذا ام^�  F 6ا�< %  B	Yes) ( B%آ �%*   &%AJ  $3%��وی�3ن 	   *%�ا�< �%*   	%No) ( Bآ 

F6 '%%�
ار و$%%� ) (Functionدا�%%*  و&<3%%�ر) (Insertادراج  ��8�%%* ا�%%E &%%;ه� ذ�%%: ��%%� A%%��$ 
�=�9%*   ا��ا�%*  &%
ع  &<3%%�ر دا�%%* ادراج$Logical �%%P دا�%%* &<3%%�ر If  �%P  F@J%&   �%	ا
$Ok)  (ف
 س%%
�V\ی A���  ا(�B ا�7
ار ا�
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�'�Uا &	

  ت=$ �H?ا��  

 A�=3�%&  *	�%<9%�ت  ا� ��  E% �  �%یO>ا�  U%�7�  �%V\�  �%��  A%<ش%�  وj$  وس�%� ذ�%:  و���%'  ا�< �%*  �%'  ا�
 F@J%&  E% �  *%� >اد  ا��%� �� �%�   و&<3%�ر ) (Insertادراج  ��8�%*  ا�%E  &%;ه�  V� �  �%P%�  �� �%�  ا>%�	*  ا�

Comment ف
 ا�%%��34* &4�%%' و��%%�$� &�ی%%�ة ا�%%;ي ا��3 �%%� &34%%� ص%%��وق ا�< �%%* �%%�ب ی\V%%� س%%
 F@J%&  د  &%�1ه�  ا�< �%*  خ%�رج
 ا��V%�  ا>%�I  �%�  ا�< �%*  ه%;̂  ان � %E  د(�%*  ا�< �%*  اس%�'  ا��%�  $U% d  وج%
 ا��3 �%%� �%%;ف و&<3%�ر  ا(ی�%%� ا��%�وس  �%%Tر ا�< �%*  � %%F@J%%& E ا�< �%*  $%%� ا��3 �%�  و(زا�%%* �� �%� 

Delete Comment  �%$ا��3%�ی'  ارد&%�  اذا ا  E% �  �%� �3ا�  F@J%&  رT%�  وس�%� Edit واخ�3%�ر  ا(ی�%�  ا�
Comment  

B	�2ت
  ب=_ إخ��Zرات �)#� ا�

Ctrl + A ��!ا�`7ت �  
Ctrl + B a	
  خ\ س
Ctrl + C R"ن  
Ctrl + D 72سYا �b�=ت  
Ctrl + F N!ب  
Ctrl + G  ا�9ه�ب إ�  
Ctrl + H 7ت���  
Ctrl + I 7�  خ\ م�
Ctrl + N ج��� C
  م
Ctrl + O B�'  
Ctrl + P �$��c  
Ctrl + S d2#  
Ctrl + U ت�

  خ\ ت!e ا�`
Ctrl + V &Z�  
Ctrl + X TL  
Ctrl + Y إ$�د�  
Ctrl + Z Xت�اج  

F1 ��$�"م  
F2 ���!ت  

F12 *ب�س d2#  
  

̂^�ت اYخ      ^^2�gب^^̂^�=_ م e�=�^̂^^إس �^̂^^L  ^̂^^)�^^̂^� أن�ا�� h^̂^^�� �^̂ ^^
̂^�م ا�=
^^̂^7 آ ^^
/  '^^̂^  ا�����^^̂^� ن^^̂^�`� ا3 $
^^̂^  إت
  .م!"- ن�* ا�
��`  '  إت
�م ه9ا ا�=
7 وج=
� ا3 '  م	kان #"��ت�� إن ش�ء ا3

  #"- إب�اه	* ت)'	&

Z�
  )ر�راب=� $
)م ا�

٢٩/١٠/٢٠٠٨  

٠١٠٧٤٥١٩٦٦  

hassantawfeq@gmail.com 
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�ر�-ـــت  

 ١ -تمرين  

 : اكتب البيانات التالية ثم نفذ العمليات المطلوبة لاحقاEXCELباستخدام برنامج اكسل 

  

  مبيعات الشركة الزراعية المتحدة بالطن

  

  المجموع  أبريل  مارس  فبراير  يناير  النوع

    ٢٨  ٢٥  ١٨  ٢٣  قمح

    ٢٢  ٢٣  ١٦  ١٩  شعير

    ٢١  ٢٢  ٢٢  ٢٤  ذرة

    ٢٥  ٢١  ٢٣  ٢٤  أرز

    ١٦  ٢٢  ٢٨  ٢١  حمص

            المجموع

 

 :المطلوب

 .Koufi Monotype بالخط الكوفي ١٨ كتابة العنوان الرئيسي في خلايا مدمجة حجم - ١

 .Tahoma نوع ١٢ تغيير خط عناوين الأعمدة وعناوين الصفوف إلى - ٢

 . تنسيق حجم الأعمدة- ٣

 .عمل حدود مفردة للجدول - ٤

 . تنسيق خط عمود المجوع بنمط مائل ولون أحمر- ٥

 . حساب مجموع المبيعات لكل نوع وفي كل شهر- ٦

 . توسيط الأرقام- ٧

 . عمل تظليل بلون أصفر فاتح للصف الأول والعمود الأول- ٨

 . عمل مخطط بياني على شكل أعمدة لمبيعات الشركة مع استبعاد المجموع- ٩
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 . كتابة عنوان للمخطط البياني وعناوين للمحاور- ١٠

 . عمل حدود وخلفية للمخطط- ١١

 .الجهاز على ) المبيعات( حفظ الملف باسم - ١٢

  

 ٢ -تمرين  

  

 :Tahoma ونوع ١٤ اكتب هذه البيانات بحجم خط EXCELباستخدام برنامج اكسل 

  

  المجموع  بنات  بنين  الكلية

    ٢٦٢٠  ٢٢٣٠  المحاسبة

    ١٨٥٠  ١٩٢٠  ينالتأم

    ١٠٦٠  ١٣٥٠  البنوك

    ١٤٨٠  ١٥٣٠  الإدارة

    ٢٢٥٠  ١٨٦٠  الحاسوب الآلي

        المجموع

 

 

 :المطلوب

 . ولون أزرقWord Art كتابة العنوان الرئيسي باستخدام وورد آرت - ١

 . كتابة عناوين الأعمدة والصفوف بخط غامق ومائل ولون أحمر- ٢

 .مجموع الطلاب البنات حساب مجموع الطلاب البنين و- ٣

 . حساب مجموع الطلاب في كل قسم- ٤

 . حساب المجموع الكلي للطلاب- ٥

 . تظليل خلفية خلية المجموع الكلي باللون الأزرق والخط باللون الأصفر- ٦

 . عمل حدود مفردة للخلايا وتظليل العمود الأول بلون أخضر فاتح- ٧
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 .د الطلاب في الكليات مع استبعاد المجموع عمل مخطط بياني على شكل أعمدة لأعدا- ٨

 . كتابة عنوان للمخطط البياني وعناوين للمحاور- ٩

 .Aعلى القرص » ١أقسام الكلية « حفظ الملف باسم - ١٠

 ٣ -تمرين  

 :المطلوب فتح ملف كليات الجامعة وإجراء التعديلات التالية عليه

 .قم وكتابة كلمة الرقم بتنسيق رأسي إضافة عمود جديد في بداية الجدول بعنوان الر- ١

 . إضافة الأرقام المسلسلة داخل عمود الرقم- ٢

 .١٤٥ - ٣٦٠ - إضافة صف جديد قبل صف الحاسوب الآلي، وكتابة البيانات التالية فيه القانون - ٣

 . حساب مجموع الطلاب في كلية الحقوق- ٤

 . عمل حدود مزدوجة حمراء لعمود الرقم- ٥

 .انات الصف الأول والأرقام توسيط بي- ٦

 تمثيل البيانات في مخطط بياني على شكل أسطوانة مع استبعاد صف المجموع وعمودي المجموع - ٧

 .والرقم

 . تنسيق موقع المخطط البياني وعمل إطار أحمر مزدوج وخلفية أصفر فاتح مناسبة له- ٨

 .»٢أقسام الكلية « حفظ الملف باسم - ٩

 ٤ -تمرين  

 . غامق١٤ وحجم Traditional Arabic التالي بالتنسيق المبين باستخدام الخط اكتب النص

 

  

   جنيهمصروفات الوزارات بالألف

  

  مرتبات  الوزارة
مستلزمات 

  سلعية

مشاريع 

  إنشائية
  مجموع  مدفوعات

    ٢١٥  ٢٠٩  ٢١٩  ٣٧٧  الداخلية

    ٢٠١  ٣٢٧  ٢٤٨  ٢٧٩  التخطيط

    ٣٢٩  ٣٠٤  ٢٣١  ٢٣٩  التربية
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            المجموع

            المتوسط

 

 :المطلوب

 .١٦ وحجم Andalus كتابة العنوان الرئيسي بالخط الأندلسي - ١

 .ملونة صفراء لإطار العنوان الرئيسي) خلفية( عمل تعبئة - ٢

 . كتابة عناوين الأعمدة والصفوف بالخط الغامق ولون أحمر- ٣

 . توسيط البيانات داخل الخلايا- ٤

 .التخطيط والتربية وكتابة البيانات التالية فيه إضافة صف جديد بين صفي - ٥

  

    ٢٥٨  ٢٦١  ٣٢٠  ٢٨٧  الإعلام

  

 ).مجموع الأعمدة( حساب مجموع ميزانية كل وزارة - ٦

 ).مجموع الصفوف( حساب مجموع ميزانية كل نوع - ٧

 . حساب المجموع الكلي للمصروفات في كل الوزارات- ٨

 .ول وضع حدود مفردة داخلية وخارجية للجد- ٩

 . عمل مخطط بياني لجميع المصروفات على شكل أعمدة وتنسيقه- ١٠

    .»ميزانية الوزارات« حفظ الملف باسم - ١١

  

   ٥ –تمرين 

  حساب محيط ومساحة المثلث  بمعلومية ثلاث اضلاع منه 

  

  المساحة   المحيط   الضلع الثالث  الضلع الثانى   الضلع الاول 

١٩  ١٢  ١٥      
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١٨  ٢٣  ١٠      

١٥  ١٢  ١٨      

  

   ٦ –تمرين 

  الدرجة   الاسم  م

  ٢٣  محمد سالم عبد الحميد   ١

  ١٨  نبيل على طارق  ٢

  ٢٧  احمد محمود هانى   ٣

  ١٩  على سليم محمد  ٤

  ١٨  سالم ابراهيم درويس  ٥

  ٢٥  ياسر على القاضى   ٦

  

  المطلوب 

  ترتيب البيانات ابجديا  -١

  تنازليا –ترتيب البيانات وفقا للمجموع تصاعديا  -٢

   ٧- مرين ت

  خطوات١٠ ولمسافة ٥ راسيا تبدأ من الرقم ٣تصميم متسلسلة عددية بزيادة قدرها  -١

    .تصميم جدول  لحساب طول وتر بمعلومية طول ضلعى القائمة بمثلث قائم -٢
  

  

  


